






























































































































































































































































Starting the Output Output Guide· 

START OUTPUT 

Device: 

Number of copies: 011 
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Figure OG 2-5. START OUTPUT Dialog 

To send the pictures named in the output list to your output device, 
do the following: 

1. Click on the output device you wish to use. 

2. Type the number of copies you want to reproduce, if it differs from 
the current number. 

3. To start the output, click on OK or press the Enter key. 

To return to the output list without reproducing the pictures named 
in it, click on Cancel. 
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Output Guide Starting the Output 

Note: To stop sending pictures to the output device, press the Esc 
key. OUTPUT stops only after it finishes sending the current picture to 
the output device. 

If you have just reproduced the pictures named in an output list and 
want to reproduce the pictures listed in another one, you need to 
close the current output list and open the next one you wish to 
reproduce. Then choose Start Output... from the File Menu again. 

CLOSING AN OUTPUT LIST 

To close the current output list and clear it from the screen, choose 
Close from the File Menu. 

If you did not save the current output list before choosing Close, 
OUTPUT does one of the following: 

• If the current list is new or if you have made changes to a pre­
existing list, OUTPUT displays the SAVE LIST dialog box and asks 
you to supply a name, as if you had chosen Save As... from the File 
Menu . 

• If you have not made changes to a pre-existing output list, OUTPUT 
saves it under its previous name, as if you had chosen Save from 
the File Menu. 

QUITTING OUTPUT 

When you are finished with a session of OUTPUT and wish to return to 
the GEM Desktop or a GEM application, choose Quit from the File 
Menu. 

End of Section 2 
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SECTION 3 

Menu Commands 

This section describes the commands in the Desk, File, Edit, and 
Options Menus. 

Calculator 
Clock 

DESK MENU 

New 
Open •.• 
Close 
Save 
Save As ••• 

Get Options ••. 
Save Options ..• 

Start Dutput •.• 
Quit 

Duplicate Name 
Delete Name 

Figure OG 3-1. OUTPUT Menus 

Screen •.• 
Printer .•• 
Plotter •.. 

Make Default 

The Desk Menu is divided into two sections by a dashed line. The top 
section always shows the Output Info ... command which gives you a 
dialog introducing you to OUTPUT. The bottom section, however, 
varies depending on what desk accessories you have available on your 
system. You can choose any desk accessory that's listed. 
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File Menu Output Guide 

FILE MENU 

You use the File Menu commands to open and close existing output 
lists, create and save new output lists, plus get and save options for 
your output devices. 

Table OG 3-1 describes the File Menu commands. 

Table OG 3-1. File Menu 

Command Description 

New 

Open ... 

Close 

Save 

Save As ... 

OG 3-2 

Clears the current output list without 
saving it and displays an empty, untitled 
list ready for you to add names to. 

Displays the output list you specify on 
your screen. 

Closes the current output list, removing it 
from your screen. 

Saves the current output list under its 
previous name, leaving it on your screen. 

Saves the current output list, but under a 
different name you specify. OUTPUT 
automatically adds .LlS to an output list's 
name. Always use the Save As ... command 
to save a new list. 



Output Guide 

Command 

Get Options ... 

Save Options ... 

Start Output ... 

Quit 

File Menu 

Table OG 3-1. (continued) 

Description 

Resets the current options for all output 
devices to match those in the option 
document that you select (document 
names that end in .OPT). You create an 
option document using the Save Options ... 
command. 

To restore the default options during a 
session of OUTPUT, choose the Get 
Options... command and select the 
DEFAUL T.OPT document. 

Saves the current options for all devices in 
an option document. OUTPUT 
automatically adds OPT to an option 
document's name. You can restore these 
options using the Get Options ... 
command. 

Sends the pictures named in the current 
output list to the specified output device. 

Stops OUTPUT and returns you to either 
the GEM Desktop or a GEM application. 
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Edit Menu Output Guide 

EDIT MENU 

You use the Edit Menu commands to arrange names in the output list. 

Table OG 3-2 describes the Edit Menu commands. 

Table OG 3-2. Edit Menu 

Command Description 

Add Name ... 

Duplicate Name 

Delete Name 

OPTIONS MENU 

Adds a name to the output list. 

Repeats selected name(s) in the output list. 

Removes selected name(s) from the output 
list. 

You use the Options Menu commands to select options for your 
output devices and make the current options the default settings. 
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Output Guide Options Menu 

Table 3-3 describes the Options Menu commands. 

Table OG 3-3. Options Menu 

Command Description 

Screen .. . 

Printer .. . 

Plotter .. . 

Make Default 

Sets options for your screen. 

Sets options for your printer. 

Sets options for your plotter. 

Makes the current options OUTPUT's initial 
settings for your screen, printer, and 
plotter. The Make Default command 
updates DEFAUl T.OPT, which OUTPUT uses 
to set the initial options for all of your 
system's output devices each time you 
sta~ it. You can also choose Get 
Options... and specify DEFAUl T.OPT to 
restore the default option settings during a 
session of OUTPUT. 

End of Section 3 
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Index 

A 

Activating 
new setup, SG 2-9 
windows, GS 3-24 

Active window, GS 3-24, 
GS 3-26 

Adding 
name to output list, OG 2-3 
new device/font, SG 2-5 
new item, SG 3-1, SG 3-2, 

SG 4-4 
Add Name ... command, OG 2-3, 

OG 3-4 
Add New Item command, SG 4-4 
APP (type), GS 4-2 
Application disk 

backup copy, GS 3-27 
Application icons, GS 3-11 
Applications 

assigning date and time, 
GS 4-8 

installing, GS 4-2 
saving installation, GS 4-3, 

GS 4-4 
selecting directory icon, 

GS 4-2 
starting, GS 3-27, GS 4-2 
types, GS 4-2 

Aspect ratio, OG 2-12 

Available commands, GS 3-9 
Available window, SG 1-4, 

SG 1-5 

B 

Backing up application disk, 
GS 3-27 

Backspace key 
editing text in dialogs, 

GS 3-20, GS 4-7 
Backup copies, GS 2-1 
BAT (type), GS 4-2 
Best Fit, OG 2-12 
Boldface colored type, v 
Boldface type, v 

c 

Capitalization, iv 
Categories window, SG 1-4, 

SG 1-5 
Change Item command, SG 4-4 
Changing 

information about an item, 
SG 3-4 

output device options, OG 2-8 
Choosing commands, GS 3-10 

Index-1 



Chosen window, SG 5-4 
Clear Choice command, SG 2-6, 

SG 3-5, SG 4-3 
Clear Summary command, 

SG 2-6, SG 2-7, SG 4-3 
Clearing 

all choices from summary, 
SG 2-6 

one choice from summary, 
SG 2-5 

output list, OG 2-2, OG 3-2 
Clicking, GS 3-6 

keyboard equivalent, GS 4-5 
to choose commands, GS 3-10 
to select icons, GS 3-6 

Clock, GS 4-8 
alarm mode, GS 4-8 
assigning date and time, 

GS 4-8 
bell symbol, GS 4-8 
changing mode, GS 4-8 
clock symbol, GS 4-8 
setting the time, GS 4-9 
time mode, GS 4-8 

Clock command, GS 4-8 
Close box, GS 3-24 
Close command, OG 3-2 
Close Window command, 

GS 3-26 
Closing 

directories, GS 3-24 
output list, OG 2-19 
windows, GS 3-26 

COM (type), GS 4-2 
COMMAND.COM disk, GS 4-4 
COMMAND.COM icon, GS 3-27 

Index-2 

Commands, GS 3-9 
affected by icon selection, 

GS 3-10 
available, GS 3-9 
choosing, GS 3-10 
highlighting, GS 3-10 
unavailable, GS 3 ..... 9 

Communication port, GS 2-5 
COpy FOLDERS llTEMS dialog, 

GS 3-22, GS 3-27, 
GS 3-28, GS 4-3 

Copying data, GS 3-21 
Correcting mistakes, SG 2-10 
Creating 

folders, GS 3-20 
output list, OG 2-2 

Ctrl (Control) key, GS 2-3, 
GS 4-5 

Current output list, OG 2-2 
Current settings with OUTPUT, 

OG 2-8 
Customizing list of available 

items, SG 3-1 

o 

Data 
copying, GS 3-21 
deleting, GS 3-25 

De-selecting 
icon groups, GS 3-21 
icons, GS 3-7 

DEFAUL T.OPT, OG 2-19, OG 3-3 
Default settings with OUTPUT, 

OG 2-8, OG 2-14, OG 2-15 



DELETE FOLDERS / ITEMS 
dialog, GS 3-25, GS 4-3 

Delete key 
editing text in dialogs, GS 4-6 

Delete Name command, OG 3-4 
Deleting 

data, GS 3-25 
device/font, SG 2-5 
icons, GS 3-25 
name in output list, OG 2-5 

Desk accessories, SG 1-6, 
SG 4-1 

Desk Menu, GS 4-8, SG 1-6, 
SG 4-1 

Desk Menu 
with GEMSETUP, SG 4-1 
with OUTPUT, OG 1-4, OG 3-1 

Desktop icons, GS 3-7 
moving, GS 3-7 
saving placement of, GS 4-4 

Desktop work area, GS 3-4 
Device driver, SG iii, SG 3-2 
Device options with OUTPUT, 

OG 2-8 
Dialog box, SG 2-4 
Dialogs, GS 3-10 

entering/editing text, GS 4-5 
Directories, GS 3-11 

closing, GS 3-24 
scrolling, GS 3-16 
sorting, GS 3-18 
type, GS 3-18 

Directory icons, GS 3-11 
Directory sorting, GS 3-18 

saving, GS 4-4 

Directory type, GS 3-18 
saving, GS 4-4 

DISKCOPV, GS 2-1 
Disk drive icons 

drive identifier, GS 4-1 
icon label, GS 4-1 
installing, GS 3-5, GS 4-1 
on initial GEM Desktop, GS 3-5 
removing, GS 3-5, GS 4-2 

Disk icons 
opening, GS 3-11 

DISK INFORMATION dialog, 
GS 3-10 

Disk Operating System, iii 
Displaying a menu, GS 3-8 
Distorting pictures, OG 2-12 
Document icons, GS 3-15 
Documents 

assigning date and time, 
GS 4-8 

renaming, GS 4-8 
DOS, iii 

returning to, GS 3-28 
DOS applications, GS 4-3 

taking parameters, GS 4-3 
DOS commands, GS 4-4 
Double-clicking, GS 3-6 

keyboard equivalent, GS 4-5 
setting required speed, GS 4-3 
to open icons, GS 3-22 

Down-arrow key 
moving text cursor, GS 4-6 

Dragging, GS 3-8 
keyboard equivalent, GS 4-5 
to select a group of icons, 

GS 3-20 

Index-3 



Drive identifier, GS 3-12 
Duplicate Name command, 

OG 2-5, OG 3-4 
Duplicating name in output list, 

OG 2-5 

E 

Edit Menu, SG 1-6, SG 4-3 
Edit Menu, 

with GEMSETUP, SG 4-1, 
SG 4-3 

with OUTPUT, OG 1-4, 
OG 3-4 

Editable text fields, GS 4-5 
Empty output list, OG 1":3, 

OG 2-2 
Enter DOS Commands ... 

command, GS 4-4 
Enter key, GS 2-2 

to exit dialogs, GS 3-22 
Entering DOS commands, 

GS 4-4 
Esc (Escape) key, OG 2-3, 

OG 2-10 
editing text in dialogs, GS 4-7 

EXE (type), GS 4-2 
Exit buttons, GS 3-22 
EXIT command, GS 4-4 
Exiting GEMSETUP, SG 4-2 

F 

File Menu, GS 3-8, SG 1-5, 
SG 4-2 

Index-4 

File Menu 
with GEMSETUP, SG 4-1, 

SG 4-2 
with OUTPUT, OG 1-4, 

OG 3-2 
Floppy disk icon, GS 3-4 

installing, GS 4-2 
Folder icons, GS 3-11 

opening, GS 3-15 
Folders, GS 3-20 

assigning date and time, 
GS 4-8 

creating, GS 3-20 
FORMAT (DOS command), 

GS 4-4 
Format ... command, GS 3-27 
Full box, GS 3-17, GS 3-23 
Full Scale, OG 2-12 

G 

GEM applications, GS 3-27, 
GS 4-3 

on floppy disks, GS 3-27 
on hard disk, GS 3-27 

GEM DESKTOP disk, GS 2-8, 
GS 3-4, GS 3-27, GS 4-4 

GEM DESKTOP MASTER DISK, 
GS 2-1 

GEM DEVICE DRIVER DISK # 1, 
GS 2-1 

GEM DEVICE DRIVER DISK #2, 
GS 2-1 

GEM Paint, GS 4-2 



GEM STARTUP disk, GS 2-8, 
GS 3-2 

GEM SYSTEM MASTER DISK, 
GS 2-1 

GEMAPPS folder, GS 3-15, 
GS 3-27, GS 3-28 

GEMBOOT folder, GS 3-15 
GEMDESK folder, GS 3-15, 

GS 3-22 
GEMPREP, GS 2-1, GS 3-2, 

GS 3-4, GS 3-5 
GEMSETUP 

starting, SG 1-1 
typical session, SG 2-1 

GEMSETUP.APP, SG 1-1 
GEMSETUP.TXT, SG 3-1, SG 4-4 
GEMSYS folder, GS 3-15, 

GS 3-27 
Generic application icon, GS 4-3 
Get Options ... command, OG 3-3 
Getting information about your 

setup, SG 2-2 
Getting options with OUTPUT, 

OG 2-15 
Graphics card, GS 2-2, GS 2-5 

H 

Hard disk icon, GS 3-4 
installing, GS 4-2 

Icon names, iv, GS 3-18 
Icon type, GS 3-18 

Icons, GS 3-4 
clicking to select, GS 3-6 
de-selecting, GS 3-7 
de-selecting groups, GS 3-21 
deleting, GS 3-25 
double-clicking. to open, 

GS 3-22 
highlighting, GS 3-6 
moving (desktop only), GS 3-7 
name, GS 3-18 
selecting, GS 3-6 
selecting groups, GS 3-20 
type, GS 3-18 

Incorrect setup, SG 2-8 
Initial GEM Desktop, GS 3-4 
Initial OUTPUT Screen, OG 1-2 
Install Application ... command, 

GS 4-2 
INSTALL APPLICATION dialog, 

GS 4-2 
Application Type field, GS 4-3 
Document Type field, GS 4-2 
Icon Type field, GS 4-3 

Install Disk Drive ... command, 
GS 4-1, GS 4-2 

INSTALL DISK DRIVE dialog, 
GS 4-1, GS 4-2 

Install button, GS 4-2 
Remove button, GS 4-2 

Installing disk drive icons, 
GS 3-5, GS 4-1 

Instruction, GS 2-2 
ITEM INFORMATION dialog, 

GS 4-8 
ITEM SELECTOR, OG 2-3 
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J 

Justification, OG 2-12 

K 

L 

Landscape layout, OG 2-12, 
OG 2-13 

Layout, OG 2-13 
Left-arrow key 

moving text cursor, GS 4-6 

M 

Make Default command, OG 3-5 
Menu bar, GS 3-4, GS 3-8, 

SG 1-5 
moving the pointer along, 

GS 3-9 
Menus, GS 2-2 

displaying, GS 3-8 
making disappear, GS 3-9 

Mouse, GS 2-2, GS 2-5 
Mouse button, GS 3-5 

button on left, GS 3-6 
techniques, GS 3-6 

Mouse number, SG 3-3 

Index-6 

Mouse pointer, GS 3-5 
See also pointer 

Moving 
desktop icons, GS 3-7 
name in output list, OG 2-5 
windows, GS 3-14 

Multiple windows, GS 3-22 

N 

New command, OG 2-2, OG 3-2 
NEW FOLDER dialog, GS 3-20 
New Folder ... command, GS 3-20 
New setup 

using, SG 2-9 
Num Lock key, GS 4-5 

o 

Open command, GS 3-11 
Open ... command, OG 3-2 
Opening 

disk icon, GS 3-11 
folder, GS 3-15 
output list, OG 2-17 

Options Menu, GS 4-1 
Options Menu 

with OUTPUT, OG 1-4, OG 3-4 
OUTPUT 

plotter options, OG 2-11 
printer options, OG 2-11 
quitting, OG 2-19 
repeating, OG 2-10 



screen options, OG 2-9 
selecting multiple names, 

OG 2-5 
starting,OG 1-2, OG 2-16 
stopping, OG 2-19 

Output device options 
changing, OG 2-8 

Output list, OG 1-3 

p 

adding name, OG 2-3 
clearing, OG 2-2 
closing, OG 2-19 
creating, OG 2-2 
deleting name, OG 2-5 
duplicating name, OG 2-5 
moving name, OG 2-5 
opening, OG 2-17 
saving, OG 2-6 

Periods 
in editable text fields, GS 3-20, 

GS 4-7 
Picture alignment, OG 2-12 
Pictures 

distorting, OG 2-12 
Plotter ... command, OG 3-5 
Plotter options with OUTPUT, 

OG 2-11 
Pointer, GS 3-5 

moving with keyboard, GS 4-5 
Portrait layout, OG 2-13 
Preparing your system, GS 2-:- 1 
Pre-selecting output list name, 

OG 1-1 

Pre-selecting picture names, 
OG 1-1 

PRINT (DOS command), GS 4-4 
Printer ... command, OG 3-5 
Printer options with OUTPUT, 

OG 2-11 
Prompt, GS 2-2, GS 2-4 
Proportional fit, OG 2-12 

Q 

Query, GS 2-2 
Quit, SG 2-2, SG 2-9, SG 4-2 
Quit command, GS 3-28, OG 3-3 
Quitting OUTPUT, OG 2-19 

R 

Remove Item command, SG 3-5, 
SG 4-4 

Removing disk drive icons, 
GS 3-5, GS 4-2 

Removing item, SG 3-1, SG 3-5 
Repeating output, OG 2-10 
Returning to DOS, GS 3-28 
Right-arrow key 

5 

moving text cursor, GS 4-6 
scrolling, GS 3-16 

Save As ... command, OG 3-2 
Save command, OG 3-2 

Index-7 



Save Desktop command, GS 4-3, 
GS 4-4 

Save Options ... command, 
OG 3-3 

Save Summary command, 
SG 2-2, SG 2-9, SG 4-2 

Saving 
application installation, GS 4-3 
current option settings 

with OUTPUT, OG 2-14 
new setup, SG 2-8, SG 4-2 
output list, OG 2-6 

Screen ... command, OG 3-5 
Screen options with OUTPUT, 

OG 2-9 
Scroll bar, GS 3-16 
Scrolling directories, GS 3-16 

general rules, GS 3-16, 
GS 3-17 

Scrolling points, GS 3-16, 
GS 3-23 

right-arrow, GS 3-16 
scroll bar, GS 3-16 
slider, GS 3-16 

Selecting 
group of icons, GS 3-20, 

GS 4-7 
icon, GS 3-6 
multiple names with 

OUTPUT, OG 2-5 
Set Preferences ... command, 

GS 4-3 
Setting the time, GS 4-9 
Shift-clicking, GS 4-7 

keyboard equivalent, GS 4-8 

Index-8 

Shift/Tab keys 
moving text cursor, GS 4-6 

Show as Icons command, 
GS 3-18, GS 3-20 

Show as Text command, 
GS 3-18 

Show Info ... command, GS 3-10, 
GS 4-8 

with GEMSETUP, SG 2-2, 
SG 2-4, SG 4-3 

Show Summary command, 
SG 4-3 

Size box, GS 3-12, GS 3-23 
Sizing windows, GS 3-12 
Slashes (I) 

in editable text fields, GS 4-7 
Slider, GS 3-16 
Sort by Name command, 

GS 3-18, GS 3-19 
Sort by Type command, GS 3-18 
Sorting directories, GS 3-18 
Special characters 

in editable text fields, GS 3-20, 
GS 4-7 

Special Menu, SG 1-5, SG 3-1, 
SG 4-4 

Start Output ... command, OG 3-3 
Starting 

application, GS 4-2 
GEMPREP, GS 2-4 
GEMSETUP, SG 1-1 
OUTPUT, OG 1-2, 

OG 2-16 
Starting the GEM Desktop 

from DOS, GS 3-4 
from floppy disk, GS 3-2 
from hard disk, GS 3-4 



Stopping 
GEMPREP, GS 2-3 
OUTPUT, OG 2-19 

Summary, SG 2-2 
Summary window, SG 2-3 
System clock, GS 4-9 

T 

Tab key 
moving text cursor, GS 4-6 

Text 
entering/editing in dialogs, 

GS 4-5 
Text cursor, GS 4-5 

moving, GS 4-6 
Text directories, GS 3-18 

selecting from, GS 3-19 
Title bar, GS 3-12, GS 3-14, 

OG 1-3 
dragging to move window, 

GS 3-14 
drive identifier, GS 3-12 
highlighted, GS 3-23 

To Output command, OG 1-3 
Trash can, GS 3-25 
Trash can icon, GS 3-4 
TYPE (DOS command), GS 4-4 

u 

Up-arrow key 
moving text cursor, GS 4-6 

Update Text File command, 
SG 4-4 

v 

View Menu, GS 3-9, GS 3-18 
check mark, GS 3-18 

w 

Windows, GS 3-11, SG 1-4 
activating, GS 3-24 
active, GS 3-24 

x 

y 

close box, GS 3-24 
closing, GS 3-26 
full box, GS 3-17 
initial sizes, GS 3-22 
moving, GS 3-14 
multiple, GS 3-22 
saving size and location, 

GS 4-4 
size box, GS 3-12 
sizing, GS 3-12 

Unavailable commands, GS 3-9 
Untitled output list, OG 1-3, 

OG 2-2 Z 
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DIGITAL RESEARCH -INC. 
END USER PROGRAM LICENSE AGREEMENT 

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND 
CONDITIONS BEFORE OPENING THE DISKETTE PACKAGE. OPENING THE 
DISKETTE PACKAGE INDICATES YOUR ACCEPTANCE OF THESE TERMS 
AND CONDITIONS. IF YOU DO NOT AGREE WITH THEM, YOU SHOULD 
PROMPTLY RETURN THE PACKAGE UNOPENED AND YOUR MONEY WILL 
BE REFUNDED. 

Title to the media on which the program is recorded and to the 
documentation in support thereof is transferred to you, but title to the 
program is retained by DRI or AUTHOR. You assume responsibility for 
the selection of the program to achieve your intended results, and for 
the installation, use, and results obtained from the program. 

1. DEFINITIONS - In this License Agreement, the terms: 

1. DRI means DIGITAL RESEARCH INC., 60 Garden Court, P.O. Box DRI, 
Monterey California 93942, owner of the copyright in, or authorized 
licensor of, the program. 

2. Machine means the single microcomputer on which you use the 
program. Multiple CPU systems require additional licenses. 

3. AUTHOR means any third party author and owner of the copyright 
in this program. 

4. Run-time Library means the set of copyrighted DRI language 
subroutines provided with each language compiler, a portion of 
which must be linked to and become part of your program for that 
program to run -on the computer. 



2. LICENSE 

You may: 

1. Use the program on a single machine; 

2. Copy the program into any machine-readable or printed form for 
backup or modification purposes only in support of such use. 
(Certain programs, however, may include mechanisms to limit or 
inhibit copying. They are marked "copy-protected.") Copying of 
documentation and other printed materials is prohibited; 

3. Modify the program and/or merge it into another program for your 
use on the single machine (Any portion of this program merged 
into another program will continue to be subject to the terms and 
conditions of this Agreement); and 

4. Transfer the program and license to another party if you notify DRI 
of the name and address of the other party and the other party 
agrees to a) accept the terms and conditions of this Agreement, 
~n~ h\ n~\I tho thon "11r'r'ont tr'!:ln~for' foo If ''''11 tr'!:ln~for' tho 
U.IY """/ .,uy ",I'U "',."' •• '""u •• " .... "'lUI',,",''''' ."''''_ II J"""' "' ....... ".". "'I''''' 

program, you must at the same time either transfer all copies, 
including the original, whether in printed or machine-readable form 
to the same party or destroy any copies not transferred; this 
includes all modifications and portions of the program contained or 
merged into other programs. 

You must reproduce and include the copyright notice on any copy, 
modification, or portion merged into another program. 

You may not use, copy, modify, or otherwise transfer the program, or 
any copy, modification, or merged portion, in whole or in part, except 
as expressly provided for in this Agreement. 

If you transfer possession of any copy~ modification, or merged portion 
of the program to another party, your license is automatically 
terminated. 
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3. TERM 

The license is effective until terminated. You may terminate it at any 
other time by destroying the program together with all copies, 
modifications, and merged portions ·in any form. It will also terminate 
upon conditions set forth elsewhere in this Agreement or if you fail to 
comply with any term or condition of this Agreement. You agree upon 
such termination to destroy the program together with all copies, 
modifications, and merged portions in any form. 

4.. COMPOSITE PROGRAMS 

. As an exception to Paragraph 2, you are granted the right to include 
portions of the DRI Run-time Library in your developed programs, 
called Composite Programs, and to use, distribute, and license such 
Composite Programs to third parties without payment of any further 
license fee. You shall, however, include in such Composite Program, 
and on the exterior label of every diskette, a copyright notice in this 
form: "Portions of this program, (C) 1985 Digital Research Inc." In 
cases where such Composite Program is contained in Read-Only­
Memory (ROM) chips, a copyright notice in the form listed above must 
be displayed on the exterior of the chip and internally in the chip (in 
ASCII literal form). As an express condition to the use of the Run­
time Library, you agree to indemnify and hold DRI harmless from all 
claims by you and third parties arising out of the use of Composite 
Programs. 

5. LIMITED WARRANTY AND DISCLAIMER OF WARRANTY 

DRI warrants the media on which the program is furnished to be free 
from defects in materials and workmanship under normal use for 
ninety (90) days from the date of delivery to you as evidenced by a 
copy of your receipt. 
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DRI warrants that each program which is designated by DRI as 
warranted in its program specifications, supplied with the program, will 
conform to such specifications provided that the program is properly 
used on a machine for which it was designed. If you believe that 
there is a defect in a warranted program such that it does not meet 
its specifications, you must notify DRI within the warranty period and 
in the manner set forth in the program specifications. 

ALL OTHER PROGRAMS ARE PROVIDED "AS IS" AND NEITHER DRI, ITS 
DISTRIBUTORS OR DEALERS, NOR AUTHOR MAKE ANY WARRANTY OF 
ANY KIND, EITHER EXPRESS OR IMPLIED. THE ENTIRE RISK AS TO THE 
QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. 
SHOULD THE PROGRAM PROVE DEFECTIVE, YOU (AND NOT DRI OR 
AUTHOR) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, 
REPAIR, OR CORRECTION. 

Neither DRI, its Distributors or Dealers, nor AUTHOR warrant that the 
functions contained in any program will meet your requirements or 
that the operation of the program will be uninterrupted or error free or 
that program defects will be corrected. 

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY 
ALSO HAVE OTHER RIGHTS WHICH VARY BY STATE OR JURISDICTION. 
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6. LIMITATIONS OF REMEDIES 

DRI's entire liability and your exclusive remedy shall be as follows: 

1. With respect to defective media during the warranty period: 

- DRI will replace media not meeting DRI's "Limited Warranty" if 
returned to DRI or a DRI authorized representative with a copy 
of your receipt. 

In the alternative, if DRI or such DRI authorized representative is 
unable to deliver replacement media free of defects in materials 
and workmanship, you may terminate this Agreement by 
returning the program and your money will be refunded. 

2. With respect to warranted programs, in all situations involving 
performance or nonperformance during the warranty period, your 
remedy is (a) the correction or bypass by DRI of program defects, 
or (b) if, after repeated efforts, DRI is unable to make the program 
operate as warranted, you shall be entitled to a refund of the 
money paid or to recover actual damages to the limits set forth 
below. 

3. For any other claim concerning performance or nonperformance by 
DRI pursuant to, or in any other way related to, the warranted 
programs under this Agreement, you shall be entitled to recover 
actual damages to the limits set forth below. 

4. IN NO EVENT WILL DRI, IT DISTRIBUTORS OR DEALERS, OR AUTHOR 
BE LIABLE FOR ANY LOST PROFITS, LOST SAVINGS, OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OR INABILITY TO USE ANY PROGRAM OR OTHERWISE, EVEN IF 
DRI, ITS DISTRIBUTORS OR DEALERS, OR AUTHOR, HAS BEEN 
ADIVSED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY 
CLAIM BY ANY OTHER PARTY. 

5. SOME STATES AND JURISDICTIONS DO NOT ALLOW THE 
LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATIONS OR 
EXCLUSION MAY NOT APPLY TO YOU. 
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6. The liability of DRI or its Distributors or Dealers to you for actual 
damages for any cause whatsoever, and regardless of the form of 
action, shall be limited to the greater of five thousand dollars 
($5,000.00) or the money paid for the program that caused the 
damages or that is the subject matter of, or is directly related to, 
the cause of action. 

7. SUPPORT SERVICE 

Support Service from DR!, if any, will be described in program 
specifications or in the statement of service, supplied with the 
program, if there are no program specifications. 

8. GENERAL 

You may not sublicense, rent, or lease this program. Any attempt to 
sublicense, rent, or lease or, except as expressly provided for in this 
Agreement, to transfer any of the rights, duties, or obligations 
hereunder is void. 

This Agreement will be construed under the Uniform Commercial Code 
of the State of California. 
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Warranty Support: 
Warranty Support is available to provide limited assistance with your product once you have tried to 
resolve the issue with the dealer from whom you obtained your product. Your dealer should always be 
your first choice for product assistance because that is the person who knows you and your product. The 
dealer also has priority access to technical information from Digital Research®. If your dealer cannot 
help, you may call Warranty Support at (408) 646-6464 for the following information: 

• responses to a limited number of common questions 
• information on replacement of a defective product 
• determination of whether a problem that you are having is a known problem 
• technical information on extensions of product capabilities or documentation 

Digital Research and its logo are registered trademarks of Digital Research Inc. 

DIGITAL RESEARCH® REGISTRATION CARD 
Please read the program license agreement before breaking the seal on the diskette package. If you do 
not agree to the licensing contract, you may return the package to your distributor/dealer for refund as 
long as the diskette package seal remains unbroken. Upon receipt of this registration card by Digital 
Research, you will become a registered user. Benefits to registered users may include the Digital 
Research News and notices of updates and enhancements to Digital Research software. 

I have read the Digital Research End User Program License Agreement and agree to abide by the terms 
contained in it. 

PLEASE PRINT 

YourNrune ________________________________________________________________ __ 

Comp~yName---------------------------------------------------------------

Street Address _____________________________________________________________ _ 

City ____________________________________ State _______ Zip _______ _ 

Country __________________ Postal Code ___________________ _ 

Phone Number ( ___ ) _________________________________________ _ 

Serial Number ___ _ __ -'-_ Date Obtained __________________ _ 

Product __________________________________ Version Number _____ _ 

Signature ___________________________________________________ _ 

Where Obtained: ______ Retail Store ____ Mail Order ____ M~ufacturer Rep. 

Computer Brand ________________________________________ _ 

Primary Use ____ -'Personal ______ nBusiness ______ LEducation 

How did you learn of this product? 

_____ Store Display 

____ Personal Recommendation 

_____ Magazine Article 

______ Magazine Advertisement 

____ Sales Person 

___ ~Other 

Other Digital Research Products Owned ______________________________________ _ 

Digital Research and its logo are registered trademarks of Digital Research Inc. 
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Reader Comment Card 
We welcome your comments and suggestions. They help us provide you with bettE 
product documentation. 

Date 

1. What sections of this manual are especially helpful? 

2. What suggestions do you have for improving this manual? What informatio 
is missing or incomplete? Where are examples needed? 

3. Did you find errors in this manual? (Specify section and page number.) 

GEM DesktopTM 
Second Edition: April 1985 
5054-2332-001 

COMMENTS AND SUGGESTIONS BECOME THE PROPERlY OF DIGITAL RESEARCH. 
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Drop-down menus give you a wide selection 
of commands at your fingertips, without 
cluttering up the screen. 

Use icons to perform a wide variety of 
commands. Pick up and open file folders. 
Switch disk drives. Or do calculations with 
the GEM Desktop built-in calculator. 

Copy or move information simply by 
moving icons (such as file folders) from one 
window to another. Or delete information 
si mply by dragging the appropriate file 
to the waste basket icon. 

505 -2332-001 

GEM DesktopTM software lets you control your camputer the most natural way 
possible - simply by pointing with a cursor ana presSing a button. Your 
computer's screen is arranged just like a desktop; with pictures of objects 
you 'll recognize at a glance. File folders. Disk drives. A calculator. What's more, 
GEM Desktop works with virtually every PC DOS appl ication, including 
WordStar,<lI> Lotus 1-2-3~ and Symphony.TM 
Just move a pointer on your screen to manipulate GEM Desktop drop-down 
menus, icons, and windows. Use a mouse, a graphics tablet, or, if you prefer, 
use your computer's arrow keys. Most importantly, GEM Desktop makes 
using your IBM PC easy! 

System Requirements: 

Use scroll bars to view the off-screen contents 
of any wi ndolV, and easi ly. 

Open any of your applications (such as 
spreadsheets, word processors, data bases, 
etc.) directly from GEM De ktop.Just point 
and push.a button. 

ColI/puters: IBM PC Family and IOOr., compatibles. 
Grapbics Requirements: Mu t have IBM Color Graphics Adaptor, IBM Enhanced Color Graphics 
Adaptor, Hercules Graphics Card, or compatibles. 
Pointers: Mouse Systems PC Mouse~ Microsoft Mouse~ SUlil)llagraphi cs" 12" Tablet, 
or compatibles. 
MinilllulIl Mem01y:256K RAM for PC DOS 2.X, 320K for PC DOS 3.X. 

GEM, GEM Desklop. Graphic EnviromncllI Manager, Ihe GEM IORG. tl i gi~11 Research. and Ihe tligiml Research lo!,'O are 
wddemarksor regislered Imdcmarksortligiml Research tnc. IBM is a regisll'red Imdemark orlmemalional Business 
Machines Corp. Hercules GmphiCS Card is a Imdemark or flercules ComplllerTedlllology. Mouse SI~lems and PC Mouse 
are Imdemarks or Mouse Sysll'ms Corp. Microsoft Mouse is a trademark or Microsoft CorporJlion. WordS"r is a reRislcred 

PRODUCT NAME 
IMPLEMENTATION 
VERSION NUMBER 
SERIAL NUMBER 

, 

GEM"'" Desktop 
PC DOS 
1.0 
5054 - 0000-004181 
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